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ABSTRAK

Permasalahan terkait dari perencanaan biaya, waktu, maupun mutu dari suatu proyek masih banyak ditemukan
di Indonesia. Banyaknya perubahan-perubahan yang sering terjadi pada perancangan suatu bangunan dapat menjadi
masalah karena mengakibatkan kenaikan biaya. Building Information Modelling (BIM) merupakan suatu sistem yang
mencakup beberapa informasi penting dalam proses design, construction, dan maintenance yang terintegrasi pada
pemodelan 3D. Penelitian ini bertujuan mengestimasikan biaya fondasi bore pile, pilecap dan pier menggunakan
sistem BIM yang dibantu dengan software Autodesk Revit. Pengolahan data pada penelitian ini dilakukan dengan cara
memodelkan di software Revit berdasarkan gambar bore pile, pilecap, dan pier proyek Double Track Manggarai-
Jatinegara. Setelah dimodelkan dalam bentuk 3D didapatkan output berupa schedule yang berisi biaya setiap elemen
yang dimodelkan. Berdasarkan hasil pemodelan dapat diketahui biaya pekerjaan, yakni untuk biaya pekerjaan beton
fondasi bore pile Rp 1.615.688.758,80, biaya pekerjaan beton pilecap Rp 603.551.395,50, biaya pekerjaan beton pier
Rp 131.109.648,95, biaya pekerjaan penulangan bore pile Rp 628.977.141,60, biaya pekerjaan penulangan pilecap
Rp 278.634.541,14, dan biaya pekerjaan penulangan pier Rp 128.039.822,50. Dengan menggunakan sistem BIM hasil
visual 3D yang dimodelkan sangat mudah dipahami dan dibaca, serta output data yang dihasilkan terintegrasi dengan

model sehingga meminimalisir adanya kesalahan.

Kata Kunci : Estimasi Biaya, Building Information Modelling, Revit.

I. PENDAHULUAN
1.1. Latar Belakang

Permasalahan terkait dari perencanaan biaya,

waktu maupun mutu dari suatu proyek masih banyak
ditemukan di Indonesia. Beberapa kasus cenderung
tidak disadari ketika suatu proyek berjalan.
Perbandingan perkembangan software negara Indonesia
dengan beberapa negara lain masih cukup jauh.
Banyaknya perubahan-perubahan yang terjadi pada
perencanaan suatu bangunan dapat menjadi masalah
karena mengakibatkan kenaikan biaya, memakan waktu
yang cukup lama dan sumber daya menjadi tidak efisien
dan efektif yang pada akhirnya dapat mengganggu
aktivitas proses konstruksi

1.2. Maksud dan Tujuan Penelitian

Penyusunan tugas akhir ini memiliki maksud
yaitu :

1. Membuat pemodelan tiga dimensi fondasi bore pile,
pilecap, dan pier menggunakan sofware Revit
Autodesk.

2. Menghitung volume pekerjaan fondasi bore pile,
pilecap, dan pier.

3. Mengestimasikan biaya pada pekerjaan fondasi bore
pile, pilecap, dan pier.

Tujuan penelitian ini adalah

1. Membandingkan perhitungan estimasi biaya dengan
menggunakan Building Information Modelling dan
cara manual.

2. Dapat menjadi refrensi bagi penelitian selanjutnya
yang akan membahas tentang pengunaan sistem
Building Information Modelling.

3. Sebagai tambahan wawasan untuk mengembangkan

serta memperluas pengetahuan mengenai teknologi
konstruksi berbasis BIM.

1.3. Ruang Lingkup dan Batasan Masalah
Dalam penelitian ini ruang lingkup dan batasan
masalah yang ditinjau adalah :

1. Lokasi penelitian ini dilakukan pada proyek Fly over
Double Track Manggarai-Jatinegara, yang berlokasi
distasiun Manggarai, Kecamatan Tebet, Kota Jakarta
Selatan, Daerah Khusus Ibukota Jakarta.

2. Untuk perhitungan estimasi biaya berfokus pada
pekerjaan fondasi bore pile, pilecap, dan pier MP 08.

3. Pengerjaan pemodelan menggunakan software
Autodesk Revit.

Il. TINJAUAN PUSTAKA
2.1. Tinjauan Umum

Manajemen proyek adalah sekelompok alat,
proses, dan sumber daya manusia yang berkompeten
untuk mengerjakan aktivitas-aktivitas yang berkaitan
dan berusaha untuk menggunakan sumber daya secara
efektif untuk menyelesaikan proyek secara efisien dan
tepat waktu. (Dimyati dan Nurjaman, 2014).
2.2. Rencana Anggaran Biaya

Rencana anggaran biaya ialah perhitungan
banyaknya biaya yang diperlukan untuk bahan dan
upah, serta biaya-biaya lain yang berhubungan dengan
pelaksanaan bangunan atau proyek tersebut (Ibrahim,
1993). Perhitungan RAB pada prinsipnya diperoleh dari
jumlah seluruh volume tiap pekerjaan dikali dengan
harga satuan masing-masing pekerjaan. Volume
pekerjaan dapat diperoleh dan dihitung dari data gambar

Jurnal Tugas Akhir Fakultas Teknik Universitas Pakuan



desain.
2.3.  Volume Pekerjaan

Volume pekerjaan merupakan perhitungan secara
rinci volume atau kubikasi suatu pekerjaan. Pada suatu
proyek, volume pekerjaan dalam satu-satuan (Ibrahim
2003). Perhitungan volume didasarkan pada gambar
detail dari bestek yang tersedia, termasuk perubahan dan
tambahan yang diberikan pada saat pemberian
penjelasan.
2.4. Fondasi

Fondasi merupakan bagian dari struktur yang
berperan dalam menopang dan menyalurkan beban-
beban yang bekerja ke dalam tanah dan batuan yang
terletak dibawahnya. Tegangan-tegangan tanah yang
dihasilkan kecuali pada permukaan tanah merupakan
tambahan kepada beban-beban yang sudah ada dalam
massa tanah dari bobot sendiri bahan dan sejarah
geologisnya (Bowles, 1988:1).
2.5. Pilecap

Pilecap adalah elemen penting dari suatu struktur
bawah. Hal ini dikarenakan pilecap memiliki peran
penting dalam penyaluran beban struktur kedalam
fondasi untuk kemudian diteruskan kedalam tanah.
Pilecap juga berfungsi mengikat fondasi kelompok,
sehingga gaya-gaya dari kolom tersebar rata kepada
fondasi. Secara analitis, pilecap akan menerima gaya
aksial dari kolom, tekanan tanah dan daya dukung dari
fondasi. Gambar pilecap dapat dilihat pada Gambar 2.1.
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Gambar 2.1 Pilecap
“Sumber : Data Proyek Waskita 2020”

2.6. Pier

Pier (pilar) merupakan salah satu komponen
jembatan yang berfungsi penyalur beban dari pier
head ke pilecap yang bertujuan agar beban yang tersalur
dari pier head ke girder dapat diarahkan dengan baik.
Pilar merupakan elemen struktur tekan yang memegang
peranan penting dari suatu bangunan sehingga,
keruntuhan pada suatu pilar merupakan lokasi kritis
yang dapat menyebabkan runtuhnya (collapse) lantai
yang bersangkutan dan juga runtuh total (total collapse)
seluruh struktur (sudarmoko,1996). Gambar pier dapat
dilihat pada Gambar 2.2.

Gambar 2.2 Pier
“Sumber : Data Proyek Waskita 2020”

2.7. Biaya Fondasi
2.7.1. Volume Fondasi

Sebelum menghitung biaya pada pekerjaan
fondasi, terlebih dahulu menentukan volume fondasi
yang digunakan. Unutk menghitung volume fondasi
bore pile yaitu:

[ Volume = Luas alas x Tinggi Tiang Bore Pile ]
2.1

2.7.2. Harga Satuan Pekerjaan

Menurut Ibrahim (1993) harga satuan pekerjaan
adalah jumlah bahan upah tenaga kerja berdasarkan
perhitungan analisis. Harga bahan didapat di pasaran,
kemudian dikumpulkan dalam satu daftar yang
dinamakan daftar harga satuan bahan. Upah tenaga kerja
didpaatkan di lokasi di kumpulkan dan di catat dalam
satu daftar yang dinamakan daftar harga satuan upah.

Dibawah ini diberikan skema untuk mendapatkan
harga satuan pekerjaan :

Huga
Jutuan
Balisx
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Gambar 2.3 Skema untuk Mendapatkan Nilai Harga Satuan
“Sumber : Diktat Rencana dan Estimasi Biaya (1993)”

2.8. Berat Tulangan
Berdasarkan SNI 07-2052-2002 dijelaskan bahwa
berat tulangan dapat dilihat pada tabel 2.1 dan2.2.
Tabel 2.1 Berat Baja Tulangan Polos

Diameter  [Luas Penampang| Berat
No. |Penamaan| Nominal(d) Nominal (L) Nominal
(mm) (cm?) (kg/m)
1. p6 6 0,2827 0,222
2. p8 8 0,5027 0,395
3. p 10 10 0,7854 0,617
4. p12 12 1,131 0,888
5. P14 14 1,539 1,21
6. p 16 16 2,011 1,58
7. p19 19 2,835 2,23
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Diameter  |Luas Penampang| Berat
No. |Penamaan| Nominal(d) Nominal (L) Nominal
(mm) cm?) (kg/m)
8. p 22 22 3,801 2,98
9. p 25 25 4,909 3,85
10. p 28 28 6,156 4,83
11. p 32 32 8,042 6,31

“Sumber : SNI 07-2052-2002 Baja Tulangan Beton”
Tabel 2.2 Berat Baja Tulangan Ulir
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“Sumber : SNI 07-2052-2002 Baja Tulangan Beton”

2.9. Building Information Modelling (BIM)
2.9.1. Pengenalan Building Information Modelling
Perkembangan teknologi pada dunia konstruksi
diharapkan dapat mengatasi masalah koordinasi yang
terjadi pada masa pelaksanaan proyek konstruksi guna
meningkatkan produktifitas agar proyek dapat berjalan
efektif dan efisien. (Eastman,2008) menjelaskan BIM
sebagai salah satu perkembangan paling menjanjikan
dalam arsitektur, industri teknik dan konstruksi. Dengan
menggunakan sistem BIM, sebuah model virtual akurat
bangunan akan dirancang secara digital. Model
bangunan yang dihasilkan oleh BIM terdapat visualisasi
geometri yang lebih tepat dan data relevan.
2.9.2. Keunggulan Building Information Modelling
Secara garis besar BIM memiliki kelebihan yaitu
dapat mendeteksi benturan saat proses perencanaan,
mengurangi limbah material, mengestimasikan biaya,
mengintegrasikan antar software tanpa harus membuat
ulang dan menghemat sumber daya manusia. Dapat
dilihat pada Gambar 2.12 pekerjaan-pekerjaan
konstruksi yang dapat dimuat dalam sistem BIM.

Gambar 2.4 Pekerjaan yang dapat dimuat dalam BIM

BIM adalah bentuk evolusi digital dari 2D
menjadi model 3D dengan database yang lengkap dan
terangkum dalam satu file. Berikut merupakan
penggunaan BIM disetiap tahapan suatu proyek:

1. Tahap Pra-Konstruksi
Pada tahapan pra-konstruksi pemilik proyek atau
owner mencoba mengestimasikan proyek yang akan
dibuat dengan anggaran yang dimiliki. Dengan
bantuan BIM dapat membuat pemodelan bangunan
dalam bentuk 3D dan bisa dilanjutkan dengan
perhitungan anggaran kasar suatu proyek.

2. Tahap Desain
Tahapan ini merupakan kolaborasi antar disiplin
ilmu untuk membuat suatu model 3D yanglengkap
dengan visualisasi yang baik.

3. Tahap Konstruksi
Pada tahap ini BIM dapat mengurangi resiko
kesalahan, mengurangi pekerjaan yang berulang,
serta menguragi biaya akibat kerusakan atau repair
karena terjadi bentrokan antar desain.

4. Tahap Maintenance
Proyek yang sudah dinyatakan selesai, akan
disimpan dalam bentuk database atau disimpan
dalam komputer, sehingga jika ingin melakukan
maintenance, hal yang pertama dilakukan adalah
membuka file BIM bangunan tersebut sehingga
dapat memudahkan proses monitoring proyek.

2.10. Revit

Revit merupakan salah satu software Building
Information Modelling (BIM) yang dikembangkan oleh
Autodesk untuk melakukan desain arsitektur, struktur,
serta mekanikal, elektrikal dan plumbing (MEP).
Dengan software Revit ini kita dapat meracang
bangunan dan struktur dengan pemodelan komponen
dalam 3D dan sekaligus menampilkan gambar kerja
dalam 2D.

Informasi model dapat diperoleh dari fitur-fitur
umum dari Revit. Menurut Rayendra dan Soemardi
(2014) rincian fitur-fitur umum dari Revit dapat dilihat
pada Tabel 2.3.

Tabel 2.3 Rincian Fitur Umum dari Software Revit

Fitur Keterangan

Massing Fitur yang berfungsi menggambar bentuk
dan geometri bangunan dengan bentuk-
bentuk yang sederhana.Massing berfungsi
untuk mengetahui  luasan, volume,
visualisasi dari bentuk bangunan dengan
keperluan analisis selanjutnya.

Software Revit dapat perubahan pada model
yang direncanakan untuk tahapan proyek
tertentu.

Phasing

Output dalamproyek dengan bantuan Revit
adalah membuat model bangunannya. Tools
yang digunakan untuk pemodelan disebut
families, library atau template yang akan
digunakan.

Modelling

Fitur Keterangan
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Rendering

Gambar tiga dimensi yang telah dirancang
sering dituntut untuk serealistis mungkin.
Hal tersebut dilakukan dengan
memperhatikan material nyata dari model,
memberikan tekstur serta pencahayaan.

Collaboration

Hasil model Revit dapatdikerjakan bersama-
sama dan diakses dari komputer yang
berbeda, dan juga software Revit dapat
diintegrasikan dengan software lain yang
dikeluarkan oleh Autdesk.

Scheduling

Revit dapat merangkai objek- objek yang
telah dibuat kedalam susunan jadwal.

Jadwal dapat terintegrasi dengan model.

“Sumber : Rayendra dan Soemardi (2014)”

I1l. METODOLOGI PENELITIAN
3.1. Data Umum
Pekerjaan pembangunan fasilitas perkeretaapian
Double Double Track (Paket A) untuk Manggarai
sampai dengan Jatinegara terdiri dari pekerjaan track
elevated, track at grade, dan pembangunan stasiun.
Berikut adalah data dimensi serta gambar kerja
bore pile, pilecap, dan pier :

1. Dimensi :

2. Mutu Bahan: Beton =K-350

Bore Pile = - Diameter 1,2m

- Kedalaman :27m

Pilecap = - Lebar :185m

- Panjang :11,5m

- Tinggi :2,5m

Pier = - Lebar 125m
- Panjang 4m

Tinggi :55m

Baja =BjTS420B

3. Gambar denah plan double track, denah bore pile,
pilecap serta detail pier MP 08 dapat dilihat pada
Gambar 3.1, 3.2, 3.3, dan 3.4.

>,

Gambar 3.1 Denah Plan Double Track

“Sumber : Data Proyek Waskita 2020”
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Gambar 3.2 Der;ah Boré Pile MP 08
“Sumber : Data Proyek Waskita 2020”

Gambar 3.3 Denah Bore Pile MP 08
“Sumber : Data Proyek Waskita 2020”

Gambar 3.4 Detail Pier MP 08
“Sumber : Data Proyek Waskita 2020”

4. Gambar tampak dan potongan Bore pile, Pilecap dan

Pier dapat dilihat pada Gambar 3.5, 3.6, dan 3.7.

i FOTOMI A ’ '_'f."'f'" :
Gambar 3.5 Potongan Bore Pile
“Sumber : Data Proyek Waskita 2020”

Gambar 3.6 Potdngan Memanjang dan Melintang Pilecap
“Sumber : Data Proyek Waskita 2020”
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Gambar 3.7 Potongan Pier
“Sumber : Data Proyek Waskita 2020”

3.2. Lokasi Proyek
Proyek ini berada di JI. Manggarai Utara, RW.1,
Manggarai, Kecamatan Tebet, Kota Jakarta Selatan.
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Gambar 3.8 Lokasi Proyeksi
“Sumber : Data Proyek Waskita 2020”

3.3.  Metode Pengumpulan Data

Data pada penelitian ini menggunakan data
sekunder berupa shop drawing, rencana anggaran
biaya, rencana kerja dan syarat-syarat, dan data tersier
berupa buku-buku serta jurnal tentang BIM dan
software Revit.
3.4. Teknik Pengolahan Data

Dapat dilihat pada Gambar 3.9 merupakan bagan
alir dari pengolahan data pada Revit, input data sekunder
dimulai dengan tahap penentuan satuan, pembuatan
pemodelan, dengan output yaitu volume, dan biaya
pekerjaan.

Gambar 3.9 Bagan Alir Pengolahan Data pada Software
Revit
3.5. Bagan Alir Pengolahan Data
Gambar 3.10 Bagan Alir Pengolahan Data.

Gambar 3.10 Bagan Alir Pengolahan Data
IV. HASIL DAN PEMBAHASAN
4.1. Pemodelan pada Software Autodesk Revit
Penelitian ini menggunakan software Autodesk

Revit 2022 yang diperoleh dengan menggunakan
Student License dari Autodesk.
411. Tahapan Pemodelan
Tahap selanjutnya melakukan pemodelan
banugnan. Pada tahapan ini akan digunakan fitur
modelling dari revit dengan langkah-langkah sebagai
berikut :
1. Penentuan Satuan
Pemodelan dilakukan dengan mengguanakan
Structural Template yang ada pada pilihan awal
software Revit. Untuk menentukan satuan dapat
dibuka pada menu Manage => Setting => Project
Units. Pada penelitian ini menggunakan satuan
mi.l.imeter (mm). Dapat d_iIi_h'at_‘pada’('Samgar 4.1.

(N -

Gambar 4.1 Tampilan Revit untuk Menentukan Satuan
“Sumber : Hasil analisis 2021”
2. Menentukan Elevasi

Untuk menggambar elevasi harus masuk ke dalam
Elevation (Building Elevation) view pada Project
Browser. Pilih diantara north, south, west, east.
Setelah view aktif, buka pilihan Structure => Datum
=> Level.

PV CRR T I et —— Ve

33 v Tl 1.

- .

. b b el

“Sumber : Hasil analisis 2021”
3. Pengaturan Grid
Membuat grid berfungsi untuk memudahkan dalam
meletakan elemen-elemen seperti fondasi bore pile,
pilecap, dan pier. Untuk menggambar grid dapat
dilakukan pada menu Structure => Datum => Grid
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Gambar 4.3 Grid untuk Memodelkan Bangunan
“Sumber : Hasil analisis 20217
4. Menentukan Rebar Cover
Untuk mengatur rebar cover (selimut beton) dapat
dilakukan dengan cara Structure => Reinforcement
=> Rebar Cover Setting.

Gambar 4.4 Penentuan Selimut Beton
“Sumber : Hasil analisis 2021”

5. Pemodelan Bangunan
a. Pemodelan Bore pile dan Pilecap

Pemodelan untuk borepile dan pilecap dapat
dilakukan dengan cara klik menu File =>Open
=> Family => Structural Foundation.
Perubahan bentuk serta ukuran fondasi dapat
dilakukan dengan menu Create Similar
kemudian buat garis sesuaikan dengan jarak antar
borepile. Selanjutnya untuk mengedit ukuran
sesuai gambar maka dapat dilakukan dengan
menu Measure => klik sisi yang akan diukur =>
Create Parameter. Contoh hasil pemodelan
borepile dan pilecap dapat dilihat pada Gambar
4.5.

_ Gambar 4.5 Model Borepile dan Pilecap
“Sumber : Hasil analisis 2021”

b. Pemodelan Pier
Pemodelan pier dapat dilakukan dengan menu
Structure => Component => Model in-Place =>
Structural Coloumns => Extrusion. Contoh hasil
pemodelan pier dapat dilihat pada Gambar 4.6.

Gambar 4.6 Model Pier
“Sumber : Hasil analisis 2021”
¢. Pembuatan Material Beton

Langkah selanjutnya adalah membuat material
pada setiap bangunan yang sudah dimodelkan.
Dapat dilakukan dengan cara Kklik model
bangunan yang sudah dibuat Type Properties =>
Material and Finishes => Opens asset browser
=> pilih material concrete in place.

- oveom

Gambar 4.7 Tampilan untuk Mengatur Material Beton
“Sumber : Hasil analisis 2021”
6. Pemodelan Tulangan
a. Pemodelan Tulangan pada Fondasi Bore Pile

- Sebelum  membuat tulangan terlebih
diperlukan membuat Section View (3D View
=> Duplicate View => Rename dengan nama
3D Rebar.

- Kemudian pilih  menu  Structure =>
Reinforcement => Rebar. Lalu akanmuncul
pilihan tipe bentuk tulangan yang akan
dimodelkan pada Rebar Shape Browser,
setelah itu pilih menu SketchRebar.
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Gambar 4.8 Tampilan'mbdel Tulangan Bore Pile
“Sumber : Hasil analisis 2021”

b. Pemodelan Tulangan pada Pilecap
Tahap awal untuk memodelkan tulangan pilecap
adalah membuat tulangan sengkang. Untuk
membuat model sengkang dengan cara (masuk
keterampilan section yang telah dibuat => pilih
menu section => pada tab properties pilih detail
view => Tarik pada sisi pilecap yang akan
dipotong) setelah membuat potongan detail dapat
dilakukanpemodelan tulangan sengkang dengan
cara sketch rebar dan sesuaikan bentuk dan
jumlah tulangan.

Gambar 4.9 Tampilan Model Tulangan Pilecap
“Sumber : Hasil analisis 2021”

¢. Pemodelan Tulangan pada Pier Coloumn

Sama hal nya pada pemodelan tulangan pilecap,
langkah awal yang dilakukan adalah membuat
tulangan sengkang pada pier dengan cara
membuat potongan detail untuk memudahkan
tampilan, setelah itu bentuk tulangan dapat
dibuat (rebar => sketch rebar => kemudian atur
jumlah dan jarak tulangan => quantity and
spacing).

: .vll'
Gambar 4.10 Tampilan Model Tulangan Pier Coloumn
“Sumber : Hasil analisis 2021”

d. Pembuatan Material Baja
Langkah selanjutnya adalah membuat material
baja pada setiap tulangan. Dapat dilakukan
dengan cara klik model banugnan yang sudah
dibuat => Type Properties => Material and
Finishes => Opens asset browser => pilih
material BjTS 420 B => setelah itu sesuaikan
pada diameter tulangan yang digunakan dengan
menu Type Properties => Type.

INEMRENERET

BN R Y STy
Ganlw::)ar 4.11 Tampilan untuk Mengatur Material Baja
“Sumber : Hasil analisis 2021”
4.1.2. Pembuatan Schedule/Quantities
Setelah gambar borepile, pilecap, dan pier
coloumn dibuat tahap selanjutnya adalah menghitung
volume material dan perkiraan biaya pekerjaan. Pada
tahap ini digunakan tahap massing yang berfungsi
mendapatkan informasi yang terdapat pada setiap model
yang sudah dibuat pada drawing area dengan cara
memilih fitur family.

Gambar 4.12 Tampilan untuk Mengatur Material Baja
“Sumber : Hasil analisis 2021”
4.2. Perhitungan Biaya dengan Revit
4.2.1. Perhitungan Biaya Pekerjaan Beton
Perhitungan biaya pekerjaan beton pada
penelitian yang mengacu ke rencana anggaran biaya
proyek.

Gambar 4.13 Output Perhitungan Beton Bore Pile
“Sumber : Hasil analisis 2021”
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Gambar 4.14 Output Perhitungan Beton Pilecap
“Sumber : Hasil analisis 2021”
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Gambar 4.15 Output Perhitﬁngan Beton Pier
“Sumber : Hasil analisis 2021”

EE T3
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Gambar 4.16 Output Perhitﬂngan Beton Pier
“Sumber : Hasil analisis 2021”

Gambar 4.21 Detail Tulangan Pilecap 1
“Sumber : Hasil analisis 2021”

Gambar 4.17 Bagian Pier pada Pemodelan
“Sumber : Hasil analisis 20217

. . ; o THITH avrome W | TTT1 TOTVRND T ) AT (ORRT EER WNIE N
42.2. Perhitungan Biaya Pekerjaan Penulangan JEII 1 I L]
Perhitungan penulangan pada penelitian ini Gambar 4.22 Detail Tulangan Pilecap 2
menggunakan harga satuan mengacu ke rencana “Sumber : Hasil analisis 2021”
anggaran biaya proyek.

Gambar 4.23 Detail Tulangan Pilecap 2
“Sumber : Hasil analisis 2021”
Didapatkan hasil total untuk volume beton bore
pile MP 08 dapat dilihat pada Tabel 4.1.

Tabel 4.1 Volume Beton Bore Pile

Gambér 4.18 Output Perhitungan Pekerjaan Penulangan
“Sumber : Hasil analisis 2021”
B

™24 D32 Uraian . TinggiTiang | JumlahTitik
Pekerjaan Diameter Bore Pile Bore Pile olumeTotal
Beton (m) (m) (Titik) (md)
Bore Pile 1,2 27,10 12 367,80

Gambar 4.19 Detail Tulangan Bore Pile 1
“Sumber : Hasil analisis 2021”

i
Gambar 4.24 Detail Tulangan Pier 1
“Sumber : Hasil analisis 2021”

Gambar 4.20 Detail Tulangan Bore Pile 2
“Sumber : Hasil analisis 20217

Gambar 4.25 Detail Tulangan Pier 2
“Sumber : Hasil analisis 2021”
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Gambar 4.26 Detail Tulangan Pier 3
“Sumber : Hasil analisis 2021”

Gambar 4.27 Detail Tulangan Pier 3
“Sumber : Hasil analisis 20217

4.3. Perhitungan Volume Secara Manual
Perhitungan manual ini didasarkan pada data
rencana anggaran biaya proyek ini. Untuk data rekap
volume mencakup volume beton dan tulangan serta data
rencana anggaran biaya terdapat harga satuan biaya.
4.3.1. Perhitungan Volume Pekerjaan Beton
A. Perhitungan Volume Beton Bore Pile
Untuk perhitungan volume beton pada satu bore
pile menggunakan rumus luas alas dikalikan tinggi
tiang bore pile. Jumlah tiang bore pile pada MP
08 ini terdapat 12 buah.

[ Volume = mr* 5 Tinggi tiang x Jumbah Bare Pile ]
4.1

Gambar 4.28 Rumus VVolume Beton Bore Pile
B. Perhitungan Volume Beton Pilecap
Pada volume pilecap dapat dihitung dengan cara
mengalikan panjang, lebar, serta tinggi pilecap.

[ Volume = Panjang x Lebar x Tinggi ]
4.2

Gambar 4.29 Rumus Volume Beton Pilecap
Didapatkan hasil total untuk volume beton
pilecap MP 08 dapat dilihat pada Tabel 4.2.

Tabel 4.1 Volume Beton Pilecap

Uraian Dimensi Volume
Pekerjaan (m) Total
Beton Panjang | Lebar | Tinggi (m®)
Pilecap 11,50 8,50 2,50 244,38

C. Perhitungan Volume Beton Pier
Pada perhitungan volume beton pier MP 08 dengan
cara hitung volume pier (panjang x lebar x tinggi)
kemudian dikurangi dengan volume blockout 1
(profil pier bagian atas), motif lengkung pada sisi
depan dan belakang, serta volume blockout 2
(sebagai tempat dudukan bearing pad).

Jurnal Tugas Akhir Fakultas Teknik Universitas Pakuan

Volume Total Pier = (panjang x lebar x
tinggi)-volume blockout 1- motif

lengkung- volume blockout 2 43

Gambar 4.30 Rumus Volume Beton Pier

Gambar 4.31 Keterangan Bagian-Bagian Pier Coloumn
“Sumber : Hasil analisis 2021~

[No| Uraian ‘l‘)l’.t;‘l‘(ﬂ‘r " Volume
| Panjang | Lebar | Tinggi = (w) |
25 4 55 S
2 06 |06 |
3 28 1| 05
&1 :'1'."-\;4:'_‘ 143 015 043
| Volume Pier T s |

~ Gambar 4.32 Volume Beton Pier Coloumn
“Sumber : Data Proyek Waskita 2020”

4.3.2. Perhitungan Volume Pekerjaan Penulangan

No D | Jarak | Panjang | Jumlah | Total | Unmit Bemat
Tulaegan | (mm}) | (mm) Batang | Panjans | Satwan | Total
{m) | (@ |Eem)| &g
B|1] 32 1200 | 24 | 631 | 181728
B|laf 32 1899 15 631 | 1.79740
B2 16| 130]10%12] M 158 | 39634
B2 16 | 130 | 54 11 158
B 16 | 300 | 1072 | 20 | 21226 | 138
B| 4| 16 |3000]| 336 19 384 | 138
B| 5| 16 [3000| 026 38 g | 138
Volume Total
YVolume Total 12 Titik Borepile

Gambar 4.33 VVolume Tulangan Bore Pile
“Sumber : Data Proyek Waskita 2020”

No D | Jusk Panjeog | Jumish | Total Unit Berat

Tulsegan | (mm) | (owm) { | Batorgg | Panjang | Saman | Total

) [ | Ldm | | fm) [ (Kgm) | (Kg) |
( | 2 150 1193 % 90668 155 140077 |
C 2| 32 | 150 | 119 | 76 | 90668 [ 572115 |
[CT 3] 25 [ 200 | 1593 | 42 | o006 | 15

( 321100 1631 | 8 [ 136043 | 631 | 83

C 5| 16 | 150 | 4196 | 14 | 56744 | 158 | 9

C | 6| 16 | 300 | 25 | w0 | 1800 | 1.8 |

Volume Total (23w |
Gambar 4.34 VVolume Tulangan Pilecap
“Sumber : Data Proyek Waskita 2020

No D harak | Panjang jumbsh | Total Ulnit Berat
| Tulasgan | (mum) | (mm) Batang | Famjang | Satuon |  Total
(m) (=) (Kg'm) (Kz)

P10 3 | 825 | 72 | 5400 | 631 | 378404
P lia| 32 | [ 7768 | 16 | 1240 | 631 | 12M
P2 32 | 7835 | 40 | 3000 | 631 | 208230
Pl 3] 16 | 100 | 1385 | 28 | 38864 | 158 | 61408
T | 3a| 16 | 200 | 1388 | 1 | 15268 | 1,58 | 26609
P ab| 16 | 75 | 938 | 7 | 6496 | LSE | 10260
F 4] 16 | 300 | 410 | 111 | 45540 | LS8 | 71906
P 5| 16 | 300 | 260 | 258 | 6993 | LS8 | LOSSA9
Pl 6| 31 | [ 630 | @0 | 28200 | 63 | 159042
Pl 71 25 | 17260 | 20 | S00 | 385 | 20020

Volame Total 115343

Gambar 4.35 Volume Tulangan Pier
“Sumber : Data Proyek Waskita 2020”



4.4. Pembahasan

Didapat volume dari perhitungan BIM lebih kecil
dari cara konvensional dikarenakan pemodelan tulangan
pada BIM dilakukan secara real sehingga panjang
tekukan tulangan diperhitungkan.

Item Pekerjaan Volume Total Pekerjaan Selisih
Konven BIM m?® %
sional
Beton Borepile 367,80 m® 367,79 m® 0 0
Beton Pilecap 244,38 m® 244,38 m® 0 0
Beton Pier 53,13 m° 53,09 m® 0,04 0,0753
Tulangan Borepile | 54.651,84 Kg | 54.480,48 Kg | 171,36 0,313
Tulangan Pilecap | 24.230,86 Kg | 24.134,65 Kg 96,21 0,397
Tulangan Pier 11.153,43 Kg | 11.090,50 Kg 62,93 0,564

TOTAL RIAVA PERERIAAN _ SELISIH BIAYA PERERJAAN

ITEM PERERIAAN

| KONVENSIONAL | REVTT (Rp) o)

-.:1.};_.5{ PR o 13765958 | 8y 12 ' o} B S0ES | ¢
Gambar 4.36 Perbandingan dan Selisih Perhitungan Bi
BIMdengan Konvensional
“Sumber : Hasil analisis 20217

$21.50 ¢ Ry

Dari hasil penelitian ini diketahui bahwa terdapat
keunggulan dari penggunaan sistem BIM. Beberapa
kelebihan BIM adalah sebagai berikut.

1. Fitur visualisasi daripada penggunaan BIM
bermanfaat dalam menggambarkan suatu projek
bangunan dalam pemodelan 3D sehingga lebih
mudah untuk dibaca dan dipahami.

2. Output yang dihasilkan oleh system BIM seperti
jenis material yang digunakan, diameter tulangan,
volume, total biaya dapat terganti secara otomatis
apabila ada perubahan model, sehingga dapat
mengefisiensikan waktu bekerja.

V. KESIMPULAN DAN SARAN
5.1. Kesimpulan
Hasil penelitian yang dilakukan dengan sistem

BIM software Revit, dapat diambil kesimpulan sebagai

berikut.

1. Setelah melakukan pemodelan pada softeare Revit
maka akan menghasilkan output data berupa
volume pekerjaan sebagai berikut:

a. Volume pekerjaan beton borepile sebesar 367,79
m3.

b. Volume pekerjaan beton pilecap sebesar 244,38
m3.

c. Volume pekerjaan beton pier sebesar 53,09 m2,

d. Volume pekerjaan tulangan borepile sebesar
54.480,48 Kg.

e. Volume pekerjaan tulangan pilecap sebesar
24.134,65 Kg.

f. Volume pekerjaan tulangan pier sebesar
11.090,50 Kg.

2. Output data dari sistem BIM tidak terbatas hanya
pada volume tetapi mencakup biaya pekerjaan
sebagai berikut :

a. Untuk pekerjaan beton fondasi borepile
didpatkan biaya sebesar Rp.1.615.688.758,80.

b. Untuk pekerjaan beton pilecap didpatkan biaya
sebesar Rp.603.551.395,50.

c. Untuk pekerjaan beton pier didpatkan biaya
sebesar Rp.131.109.648,95.

d. Untuk pekerjaan tulangan borepile didpatkan
biaya sebesar Rp.628.977.141,60.

e. Untuk pekerjaan tulangan pilecap didpatkan
biaya sebesar Rp.278.634.541.

f. Untuk pekerjaan tulangan pier didpatkan biaya
sebesar Rp.128.039.822,50.

3. Selisih biaya pekerjaan cara konvensional dengan
BIM sebagai berikut:

a. Pada pekerjaan beton bore pile tidak ada selisih
biaya.

b. Pada pekerjaan beton pilecap tidak ada selisih
biaya.

c. Pada pekerjaan beton pier didapatkan selisih
biaya sebesar Rp 0,5 atau 0,8142%.

d. Pada pekerjaan beton bore pile didapatkanselisih
biaya sebesar Rp 1.978.351,20 atau 0,3135%.

e. Pada pekerjaan tulangan pilecap didapatkan
selisih biaya sebesar Rp.1.110.737,56 atau
0,3970%.

f. Pada pekerjaan tulangan pier didapatkan selisih
biaya sebesar Rp.726.526,85 atau0,5642%.

4. Berdasarkan hasil penelitian dapat disimpulkan
bahwa perhitungan biaya pekerjaan bore pile,
pilecap, dan pier dengna sistem BIM lebih efisien
dan efektif.

5.2. Saran

Setelah  melakukan penelitian ini  penulis
memberikan saran untuk peneliti selanjutnya adalah
sebagai berikut:

1. Untuk penelitian lebih lanjut tentang penggunaan
sistem BIM, penelti selanjutnya dapat menggunakan
software yang lain seperti Naviswork untuk
membantu proses penjadwalanwaktu atau dapat juga
menggunakan software Robot Structure dari
Autodesk yang berguna sebagai analisis struktur.

2. Untuk menghemat biaya penelitian dapat
menggunakan student license agar tidak membeli
license yang cukup mahal.

3. Sebagai saran untuk memudahkan  proses
pengoperasian Revit 2022 dengan lancar diperlukan
computer dengan system requirement sebagai
berikut:

a. Sistem operasi Windows 7 64 bit.

b. Tipe CPU Intel Pentium.

c. Memori sebesar 4 GB RAM.

d. Disarankan untuk perangkat penyimpanan
menggunakan Solid State Drive (SSD) karena
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software  BIM  cukup  berat,
mempercepat proses pembacaan data.

sehingga
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